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INTRODUCTION
The Deep Foundations Load Test Data Base consists of research quality data that has been collected over the last fifteen years.  The data base consists of soils data along with the deep foundations load test data gathered from prototype load tests conducted all over the world.  The soils data include general site information, stratigraphy, laboratory and in situ test details.  The foundations data consist of general foundations information including foundation construction, and load-settlement information to failure.  Several in-depth test data are available in the data base.  For example, the information may include such data as driving records, load transfer information, various load test methods (statnamic, Osterberg, etc.), several analysis methods (failure load prediction methods), etc.

Over 1000 foundations are currently in the data base and more are being added to the data base.  A strict quality control was observed both before and after the data was entered into the data base.  Also, the data was periodically backed up and the data input was strictly administered by providing controlled access to the designated individuals.

The data base was structured to follow the rules of Relations Database Management Systems (RDBMS).  The data base resides in a Unix based Sun Solaris server and runs under Sybase RDBMS engine.  

This manual presents the user interface to access the data base, which was developed for the Internet using Java as the programming language.  The application was intended to run under any Internet capable browser (Netscape, Internet Explorer, etc.) environment.  The application uses Java applets to communicate with the data base server.

The user community includes state Departments of Transportation, geotechnical researchers, students, and practicing engineers.  Interested users can access the data base using the interface to view, download, and chart the data at run-time.

DOWNLOAD INSTRUCTIONS

The DFLT data base interface runs as a web application under an internet browser environment.  It is a ‘java applets’ based application and requires certain files to be installed on a user’s computer.  These files need to be downloaded as explained under the following two-step process:

1. Download the Java Runtime Environment (JRE1.2) plug-in from Sun’s website at http://java.sun.com/products/jdk/1.2/jre/download-windows.html
2. Download the DFLTD user query interface file dfltd.exe from the AGIDS page of the Turner-Fairbank Highway Research Center (TFHRC) website (http://www.tfhrc.gov).

Once the downloads are successful, the user must run the JRE plug-in (step 1) and install it on a computer.  The user then should run the file deepfound.exe (step 2) and install the files under the ‘lib’ folder of the plug-in directory.  For example, if the plug-in is installed in ‘C:\Program Files\JavaSoft\JRE\1.2’, then, the deepfound.exe should be run to install the files under ‘C:\Program Files\JavaSoft\JRE\1.2\lib’.  The plug-in and the supporting files are necessary to access the data base.  It is assumed that the user is set up to access the internet from the computer and has a web browser (Netscape, MS Internet Explorer, etc.) installed on the computer.  PLEASE NOTE THAT THE LATEST VERSION OF NETSCAPE (VERSION 6) IS NOT SUPPORTED YET.  

The DFLTD application has been developed using ‘java’ programming language and is operating system independent.  The instructions provided are for running the application under Microsoft Windows environment.  Users working under UNIX, MAC, and other environments should follow the same steps as above, but modified for their respective environments.

Upon completing the above installation, the user can access the data base by going to the Automated Geotechnical Information and Design-Aid System (AGIDS) page of the TFHRC website (http://www.tfhrc.gov).  The user can then enter the data base by following the appropriate links provided on the web page.

USERS MANUAL TO NAVIGATE THE INTERNET APPLICATION

The data base application address should be entered in an internet browser in order to access the data base.  The data base server is located at the Federal Highway Administration’s Turner-Fairbank Highway Research Center in McLean, VA.  The data base server is Sybase running under UNIX operating system.  The address for data base access is provided at the TFHRC website located at http://www.tfhrc.gov.  Once the address is entered, the initial screen (Figure 1) of the data base application comes up.  The screen has a welcome note along with three distinct buttons.  When the application is initially started, the third button is labeled Connecting… for some time during which period the application tries to establish a connection with the data base server.  Once the connection is obtained, the button is changed to ENTER DFLT DATA BASE.  

When the first button (ABOUT DFLTD) is clicked, a brief background of the data base is provided in a window.  As with any windows-based application, the DFLTD application uses pop-up windows in various places and these windows can be closed by clicking the ‘X’ button located at the top right hand corner.  The acknowledgements can be seen in a similar pop-up window by clicking the ACKNOWLEDGEMENTS button.  The actual data in the data base can be accessed by clicking on the third button, ENTER DFLT DATA BASE, which was described earlier.  Upon clicking this button, the main system screen (Figure 2) comes up which has several functionalities for the user.  The functionalities are explained below:

1. The first box allows the user to set the system units to either Metric or English.  In spite of this selection, the user can opt to change the units in other screens while working within the application.  The selection sets the system default units to the user’s choice.  The default selection is Metric. 

2. When the STATISTICS button is clicked, a new screen (Figure 3) comes up with a menu bar at the top.  The statistics option provides the user with the general statistics from the data base.  The statistics include information on the number of foundations, load tests, soil tests, etc. that are available in the data base and presented in a graphical format.  For example, three cases under menu item Foundations are presented here which can be extended to other menu selections as well.

When the user clicks the Foundations menu, a sub-menu appears with sub-menu items – Overall, Per State, and By State.  Clicking on the Overall item, a graphical screen (Figure 4) – Distribution of Foundations by Type – comes up, which, presents the different foundation types by their number.  The second sub-menu item provides a set of selections for the user (Figure 5) from which the user can select the Country and State.  Clicking on OK presents the graphical screen (Figure 6) – Foundation Type Distribution for Selected Country and State – which, as in the previous case, presents the different foundation types by their number, but, according to the user selected country and state.  The third sub-menu item presents the user with a selection for the Country.  Clicking on OK presents the graphical screen (Figure 7) – Foundation Type Distribution for Selected Country – which presents the number of foundations distributed by the States in the country that was selected by the user.

Similar functionalities are available for Load Tests and Soil Tests menu items.  The Construction Method menu item only has the sub-menu item Overall which behaves in a similar manner to the other Overall sub-menu items.

By clicking on the GO BACK button, the user can go back to the previous screen.

3. There is a Correlations box that has two buttons, CORRELATION and FREQUENCY DISTRIBUTION.  These are explained below:

CORRELATION:  By clicking on this button, a screen (Figure 8) with two list boxes comes up.  When the user selects any item from the left hand side list box, the right hand side list box brings up corresponding items.  The user can select a pair for which the correlations should be performed and click on the PLOT button.  For example, selecting the ‘Average Blow Count’ on the left hand side list box brings up various list box items on the right hand side list box.  From these items, ‘Cu (SPT)’ can be selected and by clicking the PLOT button, a plot as shown in the Figure 9 comes up.  The various options on the plot screen are described at the end of this document.  

Going back to the left hand side list box in Figure 8, a special case needs to be mentioned.  When the user selects ‘Failure Load’ item, then a sub-group of list box items is presented as shown in Figure 10.  These items present the criteria used to determine the failure load.  The user can select one of the criteria and click on OK button, which brings back the previous screen with the corresponding items in the right hand side list box.  For example, by selecting the ‘Davisson’ criterion and clicking OK, the items corresponding to the ‘Failure Load’ come up (Figure 11).  Here again, by clicking on some of the items (‘All Methods’, ‘Alpha Method’, etc.  Here, All Methods is selected), a sub-group of list box items presenting the load to consider (‘Total Load’, ‘Tip Load’, ‘Skin Friction’) comes up as shown in Figure 12.  The user can select a type of load (in the example, ‘Total Load’ is selected) and click on OK button, which brings back the previous screen with the user selections highlighted.  The user can click on the PLOT button to plot the correlations for the selected pair, which brings up a graph as shown in Figure 13.  The user can click on GO BACK button on any screen to go back to the previous screen.

FREQUENCY DISTRIBUTION:  By clicking on this button, a screen (Figure 14) with two list boxes comes up.  The left side list box presents failure load criteria and the right side box presents types of prediction methods.  User can choose a pair, for example select ‘Davisson’ criterion versus ‘Coyle’ method, and click on PLOT button to view the frequency distribution as shown in Figure 15.  Click on GO BACK button on each screen until one gets back to the main screen (Figure 2).

4. The GO BACK button takes the user back to the previous screen.

5. One of the most important buttons on this screen is the USER QUERY button.  This button facilitates a multitude of data base searches and gives the user access to the data in the data base.  Clicking on this button brings up a search screen (Figure 16).  The rest of the discussion in this users manual follows this screen.

DATA BASE SEARCH (FIGURE 16)

There are five tab pages on the data base search screen.  These are divided into Location, Pile Properties, Load Test, Site Investigation, and Soil Information and will be described below:

Note:  In the application, where ever there are list boxes that allow multiple user selections, the user can choose more than one item by holding down the <CTRL> key and clicking on the interested items.  The items can be de-selected by holding down the <CTRL> key and clicking on the selected items.

1. Location (Figure 17):  There are various list boxes and text boxes that the user can select from this screen.  The user can select a country from the ‘Country’ box and the corresponding states/provinces come up in the ‘State/Province’ box.  Selecting a state (or province) from this box, the corresponding cities come up in the ‘City’ box.  Please note that only those locations where the data is available will be shown in these list boxes.  The user can also select a geological province from the corresponding list box or can enter the latitude and longitude values in the appropriate places.

2. Pile Properties (Figure 18):  This tab page provides several list boxes, text boxes and check boxes.  The items presented pertain to the type of foundation, construction method, and instrumentation details.  Other pile properties like length, diameter, etc., can also be entered.  Most of the items are self-explanatory and the user can choose any items. 

3. Load Test (Figure 19):  Under this tab page, the user can select the type of loading, type of load test method, and failure load interpretation method.  Also, the check boxes are available so the user can choose a cyclic test or a test taken to failure, or a CAPWAP test.

4. Site Investigation (Figure 20):  Various in-situ and laboratory soil test methods along with the ground instrumentation are presented in this tab page.  The user can select any test of interest by clicking on the list boxes for a couple of most frequently performed tests or by checking on the check boxes.

5. Soil Information (Figure 21):  The last tab page provides the user search based on the soil at the site.  The search can be fine-tuned if necessary.  If the user is interested in a generic soil type, the drop-down box (‘Generic Description’) can be clicked and the appropriate soil type can be selected.  In this case, all the other options are disabled. 

However, if the user is interested in fine tuning the search, the generic description must be unselected (the user must not select any item).  In this event, only ADD button is enabled.  Clicking on this button, a row is added to the table and appropriate buttons are enabled.  The first two columns in the table provide drop-down boxes for ‘Geologic Origin’ and ‘ASTM / USC’.  The users may choose to select from these boxes.  The users must provide the ‘Depth’ and one of the other properties or the soil type.  After the required information is entered, if the user decides to delete a row, the row should be highlighted and the DELETE button should be pressed.  If the user chooses to search based on the cohesion and phi values, the source for cohesion and phi should be selected by clicking on the radio buttons.

In addition to the tab pages, the search screen also has various buttons.  The user can switch between the units by pressing on the Change Units button.  If the Reset button is pressed, all the selections will be de-selected and the initial state of the search screen is restored.  The user can go back to the previous screen by pressing the GO BACK button.  In order to perform the search, the user should click the Search button.  In this case, a dialog box (Figure 22) comes up presenting the user with the selections.  The user can press on the Cancel button to go back to the search screen or proceed with the search by clicking on OK button.

Clicking on the OK button, a new screen (Figure 23) comes up with a table list of foundations matching the search criteria.  The columns in this table can be re-sized and can be moved around.  In addition, the data can be sorted by clicking on any of the table headers.  The user can scroll horizontally for more columns or can scroll vertically for more foundations.  A foundation can be selected by clicking on the interested row in the table.

There are various menu items on this screen.  The Details and Unit menu items will be elaborated first.  The menu items File, Analysis, Correlations, and LRFD will be discussed afterwards.

All the subsequent screens, including this one, present the data in the default units and have a Unit (or Units) menu item, which has two sub-menu items (Metric and English) as shown in the Figure 24.  The user can select the appropriate unit and the data in the screen will be converted to the selected unit type.
The Details menu item has four sub-menu items, Foundation, Soil Test, Load Test, and GI Setup.  The Load Test sub-menu item has three more sub-items, Load Settlement, Load Transfer, and Graphs (fz,qz) as shown in the Figure 25.  These sub-menu items and sub-items are enabled or disabled based on the data available for the selected foundation.  If the data relating to the sub-menu items or sub-items is available, then the items are enabled otherwise they are disabled.

The menu items from Figure 25 are described in detail here.

· Foundation:  The foundation details can be obtained (Figure 26) by clicking on this sub-menu item.  This screen presents the foundation sections.  There are two sub-menu items under the Details menu item, Foundation Details and Construction Details, from which detailed foundation and construction information can be obtained.  Depending on the data available for the selected foundation section, the sub-menu items are enabled or disabled.

Clicking on the Foundation Details brings up a custom screen for the type of foundation that is selected.  For example, if the foundation type is ‘H-Pile’, then the screen (Figure 27) pertaining to H-piles is presented; if the foundation type is ‘Pipe’, then the pipe piles screen is presented (Figure 28), and so on.

In a similar manner, clicking on the Construction Details brings up a custom screen for the type of construction method that is used for the selected foundation section.  For example, if the construction method is ‘impact driven’ then the screen pertaining to impact driven piles (Figure 29) is presented.  Also, in the case of impact driven piles, there is a PLOT button available in the screen (as seen in Figure 29).  When the user clicks this button, a new screen plot (Figure 30) comes up.

· Soil Test:  The soil test details can be obtained (Figure 31) by clicking on this sub-menu item.  This screen presents the various soil tests that are available in the site for the selected foundation.  There are two sub-menu items under the Details menu item, Test Results and Stratigraphy, from which detailed test results and soil stratigraphy can be obtained.  Again, depending on the data available for the selected soil test, the sub-menu items are enabled or disabled.

Clicking on the Test Results brings up a custom screen for the type of soil test that is selected.  In the case of in-situ tests, if the soil test type is ‘CPT’, then the screen pertaining to the cone penetration test is presented (Figure 32); if the soil test type is ‘SPT’, then the standard penetration test screen (Figure 33) is presented; and so on.  There are PLOT buttons available to the user for plotting appropriate data in all these screens.  In the case of laboratory test, a custom screen as shown in Figure 34 is presented.  In this screen, there is a table, which presents the laboratory data and there is a PLOT OPTIONS box, which presents the plotting options in a list box based on the data available for the selected test.  The user can select any item in the list box and click on the PLOT button to plot (Figure 34) ‘depth’ versus the selected item in the list box.

In a similar manner, clicking on the Stratigraphy brings up a screen (Figure 35), which presents soil stratigraphy as obtained using the selected soil test.

· Load Test:  The information on the load test is sub-itemed into Load Settlement, Load Transfer, and Graphs (fz,qz) as previously mentioned.  Each sub-item is described in the following paragraphs.

· Load Settlement:  The load versus settlement information for the selected foundation is presented when this sub-item is selected.  In fact, there can be more than one load test performed on each selected foundation.  Three cases are described here for various types of load tests.  

· When a simple static load test is performed (Standard, Quick, Constant Rate of Penetration, etc.), the results are presented as shown in Figure 36.  The ‘Load Test Information’ table provides the information (number, type, etc.) on the load tests.  Clicking on each load test provides corresponding load-settlement information in the ‘Load-settlement Data’ table.  This data can be plotted by clicking on the PLOT button (Figure 37).

· When an Osterberg load test is performed, a similar screen (Figure 38) comes up which has the same functionality as above.  The data can now be plotted using the PLOT TIP (Figure 39) and PLOT SHAFT (Figure 40) buttons.

· In the case of the Statnamic test, the screen as shown in Figure 41 comes up.  Note that when this screen comes up, the statnamic data is being fetched from the data base as indicated at the bottom of this screen.  As described previously, the ‘Load Test Information’ table provides the information of the type of load tests available for this foundation (there can be static and statnamic test information available for the same foundation).  If the test code highlighted in the ‘Load Test Information’ table is ‘STA’ (Statnamic), then another table ‘Statnamic Test Information’ is shown below it.  This table contains the number of statnamic tests that are conducted on this foundation as a part of the selected load test.

Once all the data for the highlighted (initial) statnamic test has been fetched, the data is updated in the table on the right hand side of the screen (Figure 42).  The data corresponding to the remaining statnamic tests can be obtained by selecting an appropriate test.

Note that there is a combo box above the detailed statnamic test data table which highlights it’s initial state (in the figure, Statnamic Load vs Displacement is the initial state).  This data can be plotted by clicking on the PLOT button (Figure 43).  Depending on the data available, there may be other combinations that the user can select by clicking on the combo box.  For example, Figure 44 indicates the other choice (Derived Static and Statnamic vs Displacement) that is available to the user.  By selecting this choice, a new screen (Figure 45) with the appropriate data comes up which can be plotted as shown in Figure 46.

· Load Transfer:  The load transfer information for the selected foundation is presented when this sub-item is selected.  Here again, there can be more than one load test performed on each selected foundation.  The results are presented as shown in Figure 47.  The ‘Load Test Information’ table provides the information (number, type, etc.) on the load tests.  Clicking on each load test provides corresponding load-transfer information in the ‘Load Transfer Data’ table.  This data can be plotted by clicking on the PLOT button (Figure 48).

· Graphs (fz,qz):  By clicking on this sub-item, the qz, fz curves can be plotted.

· GI Setup:  This item is for future development.

GENERIC PLOT SCREEN OPTIONS:

The plotting screen has several features that are interactive and all these can be used at run-time.  The user can click on the check boxes for x and y axes grids, can flip and invert the axes, can put the legend and labels, and can go back and forth between a line plot and a scatter plot.  When the labels are clicked and a data point is highlighted, the values of the data point pop-up on the plot.  Another very important feature is the x and y axes units.  There is a drop-down combo box of units for each of the axes and the user can select an appropriate unit to plot the data.  The unit conversion is performed at run-time.

The menu items File, Analysis, Correlations, and LRFD will be discussed next.

· File:  The File menu has 5 sub-menu items (Figure 49), i.e., WEAP, Download, Print, Go Back, and Exit.  The subsequent screens also have a File menu item, which may have some of the same sub-menu items and their response will be the same as that of the ones described below.  Most of these items are self-explanatory.  WEAP indicates data for Wave Equation Analysis Program, and Print prints the data to the printer and these items are for future development.  Go Back takes the user back one screen and Exit exits the application completely.  

The data in the screen can be downloaded by selecting the Download sub-item.  When the user clicks on this button, a save dialog box (Figure 50) comes up, where the user can choose the directory and file name to save the data in.

· Analysis:  The Analysis menu (Figure 51) presents several sub-menu items which are indicated by a specific type of analysis method (Nordlund, Coyle, etc.).  These are the most commonly used failure load prediction methods that use various soil and foundation criteria to analyze for the foundation load capacity.  These items are enabled, based on the data available for the selected foundation.  Once the user selects one of the enabled items, the analysis information is presented as shown in Figure 52 (for Nordlund’s Method).  The results for the other methods are presented in a similar manner.

· Correlations:  The correlations are presented for all the foundations that are retrieved based on the user search criteria.  All the screens are similar to the ones discussed earlier for the system Correlations.

· LRFD:  The user can choose to download the data for Load and Resistance Factor Design (LRFD).  The data will be presented (Figure 53) in a format compatible for LRFD calibration.  The user can select the Download sub-menu item from File menu to download this data into a file.

NOTES AND TROUBLESHOOTING:
· Netscape 6 is not compatible with the application.  Please continue to use Netscape 4.x.  Sometimes, MS Internet Explorer (IE) seems to run under problems.  If so, under IE please go to Tools -> Options -> Temporary Internet Files -> View Objects and remove the Java 1.2 Plug-In.  Then, start the application (one may have to re-install the Java Plug-In).

· If the application does not run, please make sure that the files, ‘Agids.jar’ and ‘deepfound.jar’, are located under the ‘lib’ folder of the Sun’s Java Plug-In directory.  Otherwise, make sure you run the file ‘dfltd.exe’ (downloaded earlier) and type in the correct path of the ‘lib’ folder of the plug-in.

· The application works best under 1024 x 768 pixels screen resolution (Check your screen resolution under Control Panel -> Display -> Settings).

· If the user loses the internet connection while navigating the data base then the application needs to be restarted.

· Some of the screens may take a little longer to come up.
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Figure 1.  Startup screen for the DFLT data base internet application
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Figure 2.  Main screen for the application
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Figure 3.  Statistics Screen
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Figure 4.  Statistics Screen:  Distribution of Foundations by Type
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Figure 5.  Statistics Screen:  Country and State Selections
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Figure 6.  Statistics Screen: Foundation Type Distribution for selected Country and State
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Figure 7.  Statistics Screen:  Foundation Type Distribution for Selected Country
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Figure 8.  Correlations Screen:  User Choices
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Figure 9.  Correlations Screen:  Average Blow Count versus SPT Cu (kPa)
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Figure 10.  Correlations Screen:  Sub-options for the Failure Load Criterion
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Figure 11.  Correlations Screen:  Items in the RHS List Box Correspond to Failure Load Criterion (Davisson Selected) in the LHS List Box
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Figure 12.  Correlations Screen:  Sub-options for All Methods
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Figure 13.  Correlations Screen:  Failure Load by Davisson (kN) versus All Methods Total Capacity (kN)
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Figure 14.  Frequency Distribution:  User Choices
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Figure 15.  Frequency Distribution:  Coyle Predicted Capacity based on Davisson’s Failure Load
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Figure 16.  Data base Search Screen
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Figure 17.  Search Screen:  Location
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Figure 18.  Search Screen:  Pile Properties
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Figure 19.  Search Screen:  Load Test
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Figure 20.  Search Screen:  Site Investigation
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Figure 21.  Search Screen:  Soil Properties
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Figure 22.  Search Screen:  User Selections
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Figure 23.  Search Results:  List of Foundations
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Figure 24.  Generic Unit(s) Sub-menu
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Figure 25.  List of Foundations:  Details Dropdown Menu 

[image: image25.png][ Sections o
Fle DetailsUnits

AD TRANSFER # 35-

CA Foundation: 1

[_[CIx]

SectionID

Foundation Type

Canstruction Method

Section Length
(m)

sH

Impact Driven

a4

GO BACK





Figure 26.  Foundation Information
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Figure 27.  Foundation Details:  H-Piles
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Figure 28.  Foundation Details:  Pipe Piles
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Figure 29.  Construction Details:  Driving Records
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Figure 30.  Construction Details:  Plot of Driving Records
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Figure 31.  Soil Test Information
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Figure 32.  Soil Test Details:  Cone Penetration Test (CPT)
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Figure 33.  Soil Test Details:  Standard Penetration Test (SPT)
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Figure 34.  Soil Test Details:  Laboratory Tests
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Figure 35.  Soil Stratigraphy Screen
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Figure 36.  Load Test Information:  Load-Settlement Data
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Figure 37.  Load Test Information:  Load-Settlement Plot
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Figure 38.  Load Test Information:  Osterberg Load-Settlement Data
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Figure 39.  Load Test Information:  Osterberg Load-Settlement Data:  Tip Settlement 
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Figure 40.  Load Test Information:  Osterberg Load-Settlement Data:  Shaft Settlement 
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Figure 41.  Load Test Information:  Statnamic Test Data Being Fetched 

[image: image41.png][ELoad-Settiement for Dayton: [-1o[x]
Fle Details Units
Foundation nformation Statnamic Load Vs Displacement =
Tywe ac
Load Level Displacement
Length 9.14m N )
Diameter wstcm e T =
Const.Method  ACNP fo0s 0
-0.00 [
Load Test Information -0.08 00
008 [
Test# | Test Load -0.00 [
coe | Twe 000 [
T & 008 [
-0.00 [
-0.00 [
008 [
-0.00 [
008 [
Kai7777777777 e ) Wl vy 0
-0.00 [
-0.00 [
Statnamic Test Information 008 [
008 [
Test | MaxDispl | MaxLoad || |-0.08 [
D (mm) Ny -0.09 0o
1 152 0.56 .09 00 !
2 014 172
5 1041 250 pror

1722 rows fetched.




 

Figure 42.  Load Test Information:  Statnamic Test Data:  Derived Static vs Displacement
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Figure 43.  Load Test Information:  Plot of Statnamic Test Data:  Derived Static vs Displacement
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Figure 44.  Load Test Information:  Statnamic Test Data: Combo Box Options
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Figure 45.  Load Test Information:  Statnamic Test Data:  Derived Static and Statnamic vs Displacement
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Figure 46.  Load Test Information:  Plot of Statnamic Test Data:  Derived Static and Statnamic vs Displacement
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Figure 47.  Load Test Information:  Load Transfer Data
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Figure 48.  Load Test Information:  Plot of Load Transfer Data
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Figure 49.  File Menu Sub-Items
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Figure 50.  Download: Save Dialog Box
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Figure 51.  Analysis Menu Sub-Items
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Figure 52.  Analysis:  Nordlund’s Method
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Figure 53.  LRFD Calibration
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